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Chapter 1: 
About AnSWR 
 
AnSWR is a software program for coordinating and implementing large-scale team-based qualitative 
data analysis. It was developed by the Centers for Disease Control and Prevention as a free (public 
domain) tool to assist with applied research. Although the program was originally developed to assist 
with managing and analyzing large multi-site research studies that integrate qualitative and 
quantitative techniques, it can also effectively be used by a single researcher for more limited 
research projects. 

Recognizing the challenge that researchers face in trying to manage, process, and analyze large 
volumes of data generally produced by qualitative research as well as the potentially complex, 
multifaceted issues associated with a single research topic, AnSWR was designed with a systems 
approach in mind (1). A systems approach has three underlying principles: systematic scientific 
inquiry is supported, complexity is the organizing framework, and data is object-oriented. 

Given the increased interest in and use of qualitative research in both public and private settings, the 
assurance of data rigor and documentation of research procedures becomes increasingly important 
(2).  Collaborative qualitative research efforts lacking systematization quickly run the risk of falling 
apart or becoming individual endeavors.  Systematization does not curb creativity or limit analytical 
flexibility.  Rather, it enables the analysis research team to coordinate and consistently apply 
procedures, explain how analytical decisions evolved, and to examine the validity of the analytical 
lens used to frame, filter, and present information.  It provides the “audit trail” necessary for 
explaining how concepts, theories, and hypotheses are developed (3).  With computers, the “audit 
trail” becomes easier to access and maintain. 

Qualitative data analysis of unstructured or semi-structured textual data generally entails coding and 
indexing of ideas or themes, ordering codes, and establishing relationships between codes (4-6).  
Codes, however, are not linked just to segments of text.  They are connected to other important data 
elements, such as whom or what provided the information and who interpreted the information. In 
turn data elements are characterized by particular features or attributes that may be important in 
understanding and interpreting phenomenon. 

Among AnSWR’s features are tools to organize and streamline common tasks necessary for 
systematic analysis of lengthy, complex text such as that associated with open-ended interviews. For 
example, AnSWR can help a researcher create and maintain codebooks; create links to documents 
stored on a local drive, a network, or the World Wide Web; develop hierarchical connections among 
codes; assess intra- and intercoder agreement; and flexibly segment and apply codes to text passages. 
Text retrieval is aided by the ability to selectively choose sub-sets of information using search 
parameters such as files, codes, coders, segments, and attributes of information sources. 

More than 30 easy-to-use report formats are included with the AnSWR system. These pre-defined 
reports allow researchers to rapidly summarize their work in different formats such as narrative text, 
descriptive tables, or matrices that can be import to other software systems for additional analysis. 
Researchers can also customize reports to display information in a particular order or to include 
their own logos. 
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Textual data can be typed into the system directly or it can be linked as plain text file (TXT) or rich 
text formatted file (RTF). Textual data requires no special formatting and file size limitations are not 
imposed. Since the system creates a set of relational databases as opposed to individually coded data 
files, the analyst has a great deal of flexibility in how text files are set up and examined. 

System Overview 

The Study 
In AnSWR, a Study provides the basic organizing framework for a coordinated research effort. 
AnSWR permits you to document information about the research design and analysis objectives of a 
research “Study.” Minimally, three types of information are associated with a Study: 

• Sources – who or what provides the textual data 

• Codes – labels used to organize/classify concepts and retrieve textual data 

• Coders/analysts – who applies the codes and interprets the textual data 

The Study can also include source data. Source data characterizes sources on one or more 
properties.  Source data can be used to filter or limit analytical output. Generally, source data is 
derived from a respondent profile, standardized questionnaire (e.g., demographic, behavioral or 
psychological assessment, performance evaluation) or an attribute/categorization resulting from the 
analysis or some other means (e.g., researcher-developed). Similar to a quantitative database, the 
source data captures the degree, presence/absence, or frequency of specific information. 

When a new Study is created, a database named study30.mdb is automatically set up. The database 
reflects all additions or modifications to the Study sources, codes, source data or coders/analysts.  

Note: In AnSWR, codes are different from source data. Source data tells you something about who 
or what provided the textual data, such as an interviewee’s age, ethnicity, sex, health status, 
education, employment, professional or social network. Codes are what you have used to index or 
encode information provided by your source(s). Codes tell you something about what is contained 
in an interviewee’s story, his/her response or comment to a question, or description about an event 
or process. Codes signal that particular content and context is present or absent. In addition, codes 
should indicate why you have interpreted that a particular indexing or classification of the textual 
data is appropriate. 

The Project 
A Project typically includes all the textual data that will be analyzed, including pictorial images or 
non-text based data objects. For example, textual data can be in the form of observation notes, 
interview transcripts, historical documents, meeting minutes, publication abstracts, ethnographic 
maps, drawings, or musical scores. All coding and report processing is at the Project level. 

A Study must contain at least one analysis “Project.” A Study can include an unlimited number of 
Projects, each with a smaller, more focused, research objective. Some Projects may build on each 
other sequentially, while others can be undertaken simultaneously. 

 
 

2



    

For Studies in which multiple Projects are created, the Study becomes a repository for all the codes, 
sources, and coders/analysts associated with all the Projects. Hence, any of these items can be 
shared across Projects. Each Project, however, may have its own set of textual files. 

If multiple analyses are planned, the criteria listed below may help you determine whether to set up 
(a) a single Study with multiple Projects or (b) multiple Studies that are each associated with a single 
Project. 

If you are unsure of which approach is appropriate for your analysis needs, keep in mind that you 
can use the AnSWR merge wizard to help you to merge Studies or Projects, split them up, or 
borrow sources and codes from any Project at a later time. 

Note: Codes used across multiple Projects or Studies should be applied consistently. That is, the 
meaning of the code should change from one analysis to another. When applying codes under new 
conditions, makes sure that the original intent of the code does not get lost. Code application must 
match the definition that has been established via previous coding. 

When a new Project is created, a database named project3.mdb is automatically set up. All analyses 
are written to this database. Textual data files are also associated with the project3.mdb file.  

System Layout 
Use Windows Explorer or My Computer to view the system layout.  By default, AnSWR creates 
separate Study and Project folders under the main AnSWR directory. The Study location, however, 
may be changed to another folder or physical drive on a network. 

Unless otherwise specified, AnSWR is installed under a folder named AnSWR under the 
C:\Program Files folder. Three system folders are found under the AnSWR folder: Reports, 
HelpSystem, and System. These folders should not be modified or removed. 

Folder Files Description 

 

 

Contains the system 
help files 
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Folder Files Description 

 

 

Contains the system 
report modules 

 

Note: These files 
should not be 
modified 

 

 

Contains the system 
databases 

 

Note: These files are 
used by the system 
when creating new 
Studies and Projects 

Never modify these 
files 

 

The Study Folder 
AnSWR sets up a folder for each Study that you create. The folder is automatically assigned the 
same name as the Study. Once a Study name has been established it cannot be modified or renamed. 
If changing the Study name is required, the Project Merge Wizard can be used to duplicate the Study 
under a new name.  See Chapter 4 for help on using the Project Merge Wizard. 

In the tree diagram below, a Study named VISION was created in AnSWR. 
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If you were to click on the plus sign next to the VISION folder, the tree diagram would expand to 
display its contents. Inside the VISION folder you would find the study30.mdb. Study information 
(optional), sources, sources data (optional) coders/analysts, and codes are written to this database. 

 
Study information essentially refers to the overall research design (i.e., Study title, investigators, 
rationale, objectives, data collection and sampling methods, data preparation procedures, analysis 
plan, etc.). While AnSWR provides basic fields for documenting this type of information, you may 
create your own fields using the Advance Study Utility. 

Note: Traditional databases are organized by fields, records, and files. A field is similar to a variable 
in that it is only a single piece of information; a record is one complete set of fields; and a file is a 
collection of records. 

The Project Folder 
A separate folder is created for each Project associated with a Study. The folder is automatically 
assigned the same name as the Project. Once a Project name has been established, it cannot be 
renamed.  If a change in the Project name is required, the Project Merge Wizard can be used to 
duplicate the Project and assign it a new name. 

In the tree diagram below, VISION Study includes a Project named Access to Care. 

 
If you were to click on the on the plus sign next to the Access to Care Project folder, the tree 
diagram would expand to display its contents. Inside the Access to Care Project folder you would 
find three databases: project3.mdb; accesswc.mdb; and textdata.mdb. 

 
 

Text, sources, coder/analysts, codes, and text segments specific to a Project analysis are written to 
the project3.mdb database. 
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The Access to Care accesswc.mdb includes any word count analysis performed. The word count 
database remains empty until Word Count Administration is selected as an analysis preference. 

The Access to Care textdata.mdb contains all textual data directly entered in AnSWR. Each direct 
text input is saved as record in this database. For team-based analyses, always use direct text input. 
This avoids having all coders/analysts encounter problems in physically locating textual data files or 
using different versions of a file. 

System Utilities 
AnSWR includes five data maintenance utilities that can be accessed without running AnSWR. To 
initiate any of these utilities click on Start, then Programs, then AnSWR on your computer.  

• Code Sources Utility – keeps codes and sources synchronized between two or more related 
Studies and ensures that coders/analysts working on the same analysis Project have 
consistent codebook and sourcebook entries. This utility can also be used to bring in or borrow 
codes from unrelated Studies. 

• Coder Cleanup Utility – identifies inactive coders/analysts from Studies and Projects. If a 
listed coder/analyst has not performed any sources- or text-based coding, you have the option of 
deleting coders/analysts from the Study and Project databases. 

• AnSWR Update Utility – determines if you are running the most current release of 
AnSWR available. An Internet connection is required to run this utility. The system gives 
you the option of downloading and automatically installing an upgrade patch. This utility is 
also available through the AnSWR Coding Editor. 

• Database Compact Repair Utility – removes fragmentation and optimizes database 
performance. This utility is also available through the AnSWR Study Manager Window. 

• AnSWR Package Utility – compresses and extracts shared Studies or Projects. 

Database Compact & Repair 
If you delete data from an AnSWR Study or Project, the study30.mdb and project3.mdb database 
files can become fragmented and result in inefficient use of disk space. When compacting a database 
file, a temporary backup of the file is made. The system then rearranges how the file is stored on 
your computer or network server. Once this process is completed, the backup file created by the 
system is removed. 

If the system detects that a selected Study or Project has been damaged or is corrupt, it automatically 
repairs the database when the file is compacted. If you have a Study or Project that does not open or 
is behaving unpredictably, use the Database Compact Repair Utility to correct the problem. 

Compacting optimizes the performance of your AnSWR databases. Hence, Study (study30.mdb) and 
Project (project3.mdb) databases should be compacted periodically. 

Note: The system only creates a temporary backup of your selected database file. As an extra data 
security measure, you should always create a backup copy of your selected databases prior to 
running the Compact Repair Utility.  
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From Start, go to Programs, and locate AnSWR. Click on the arrow to display the drop-down 
menu. Select the AnSWR Database Compact Repair Utility. Locate the folder containing the 
Study (study30.mdb) or Project (project3.mdb) database that you want to compact/repair, click the 
Open button, click the Repair Database button, and then click OK to the prompts that follow. 

Note: If you are trying to compact a database that is accessed by multiple coders/analysts and is 
located on a shared server or shared folder, first make sure that no other users have it open. 

Typical AnSWR Analysis Sequence 
• Create a Study  
• Setup a Project 
• Add textual data 
• Enter sources 
• Add source demographic data (optional) 
• Create codebook 
• Create text segment 
• Source code text segment 
• Code text segment 
• Generate analysis reports  
 

KEY TERMS 

STUDY - basic organizing framework for a coordinated research effort. Study-related 
information is stored in database named study30.mdb. Each Study will have a study30.mdb file. 

PROJECT – level at which all processing and analysis occurs. Project-related information is 
stored in a database named project3.mdb. Each Project will have a project3.mdb file. 

SOURCES - who or what provides the textual data 

SOURCES DATA - tells you something about the person or group that provided the textual 
data (e.g., age, ethnicity, sex, health status, education, employment, and professional or social 
network). 

TEXTUAL DATA – text or graphics that will be analyzed (e.g., observational notes, interview 
transcripts, historical documents, minutes of meetings, publication abstracts, maps, drawings) 

CODES - labels used to organize/classify concepts and retrieve textual data. 

CODER/ANALYST – person who applies the codes and interprets the data. 
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Chapter 2: 
Getting Started 
 
AnSWR requires a few preliminary steps before actual coding of the textual data can begin. The 
standard sequence is as follows: 

1. Log in to AnSWR 

2. Create an analysis Study 

3. Setup an analysis Project 

4. Add text or image file(s) 

5. Input the data source(s) 

6. Enter and define code(s)  

To add data files, sources, or codes, choose the Modify a Project option from the File menu, or 
click the Modify Project button in the Coding Editor.  

AnSWR Login 
The system requires a user-defined login consisting of coder/analyst ID and password. These items 
may be up to eight characters long and can include letters and numbers. Special characters are not 
permitted.  

Logins serve two purposes: 

• Allows more than one coder/analyst to process code in the same Project without deleting or 
modifying one another’s work. 

• Identifies what areas of the system a user may access. 

User rights are generally determined by the person creating the Study. Typically, this individual is the 
Study Administrator. The four levels of user access are specified below. 

• Coder/Analyst can process data and generate reports  

• Reporter can generate reports, but may not enter or process data 

• Project Administrator can process data, generate reports, and assign coder/analysts, but 
cannot modify Study codes that have been locked by the Study administrator 

• Study Administrator can process data, generate reports, assign coder/analysts information, 
and modify Study codes 

The Study Administrator may also set up a Study password. When the Study is opened, the system 
displays a prompt requesting the password. If an incorrect password is entered, the Study will open, 
but the user will have only reporter rights. 
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First-time users should enter a unique Coder/Analyst ID of their choice and then enter NEWUSER 
(one word, case sensitive) as the password. The system will display a Coder/Analyst information 
window for the user to complete.  

Studies and Projects 

The Study Manager Window 
The Study Manager window will always display after a login has been completed. The first time that 
the system is used, the Study Manager window will prompt you to create a new Study. 

Although the Study name does not need to be limited to a particular number of characters, it is 
suggested that you keep the name brief for display purposes. If you are running the system from a 
network server, Study names should be limited to eight alphanumeric characters. 

 
Note: Unless you have otherwise specified, AnSWR is installed under C:\Program Files. By default, 
Studies are saved under C:\Program Files\AnSWR. 

Reminder: Once a new Study has been created, the system sets up a Study folder with the same 
name and writes a blank study30.mdb database to the folder. Any Study–related information you 
enter will be automatically written to the appropriate study30.mdb table. 

Other items on the Study Manager Window include: 

• A File menu that duplicates the system functions available via icons in the AnSWR Study 
Manager Window 

• A Tools menu that gives you access to the AnSWR Compact Repair Database Utility  

• Icons for creating a new Study, opening an existing Study, deleting a Study, accessing the 
system Help file, and exiting AnSWR. 

 
 

9



   

  

The Project Wizard 
 
After a Study has been created, the Project Wizard will prompt you to create a new Project. This 
process creates a Project folder under the Study folder 

 
At minimum, you must enter a Project name. Again, it is recommended that Project names be kept 
brief. More detailed information about the Project can be entered in the Project Description field. 
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Note: If multiple coder/analysts are coding text for the same analysis and each will be completing 
their coding on a separate computer, it is recommended that the AnSWR Package Utility be used.  
See Chapter 10 for help on using the AnSWR Package Utility.  Alternatively, each coder’s first or last 
name can be assigned as the Project name. If multiple coders will be completing their coding on the 
same computer or network, no special Project naming convention is required. The system will use 
the coder/analyst login to assign analysis with the appropriate coder/analyst ID. 

Once a Project name has been saved, it cannot be modified. You may opt to complete the Project 
Description and Analysis Objective fields at any time. Unlike the Project Name field, these fields 
are intended to store lengthier, more detailed information. 

The Project Description and Analysis Objective fields are important in stating the rationale and 
defining the specific foci and objectives of the analysis Project. It is recommended that these fields 
always be filled in before an analysis Project is completed. Because these fields can be modified at 
any time, adjustments can be made if the focus of the analysis changes. 

AnSWR requires that a source be assigned to all units of text that are coded. If you do not wish to 
differentiate between sources, or have only one source (e.g., a single researcher, a case Study, or a life 
history), click on the check box to always have the system assign a default source. In this case, the 
system will assign AnSWR as the source.  

 
Note: The default sources can be changed. See Chapter 6 for help for creating a user-defined default 
source. 

CDC EZ-Text databases can also be imported for further analysis or reporting in AnSWR. To 
import CDC EZ-Text databases, click the Import Project from an existing EZ-Text 3 Project check 
box. 

 

New Study 
To create a new Study follow the steps outlined below: 

1. Click the New Study button. 

2. Enter a name for the new Study. 

3. Change Study location if different from default. 

4. Click the Save Study button. 

The Project Wizard starts up and prompts you for the Project to add. 

Note: The system only detects Studies that have been identified by this process.  
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Chapter 3:  
The AnSWR Main Window 
 
After you create a Study, the AnSWR main window is displayed on your desktop. By default, the 
window displays on the top right-hand corner of your desktop. The window can be placed elsewhere 
on your desktop. The system will “remember” this new location each time the window is displayed. 

The window displays: 

• Three dropdown menus: File, View, and Help 

• The version of AnSWR you are currently running 

• The active Study’s name 

• The active Project’s name 

• The active coder/analyst’s ID 

• Icons with links to key system functions 

ICON FUNCTION 

 Open a Project 

 Open Codebook Editor 

 Open Sourcebook Editor 

 Open Coding Editor  

 Open Reports Manager 

 Open Help File 

 Close AnSWR 
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File Menu 
The following system functions can be accessed from the File menu: 

• Study Information Manager 

• New Project 

• Open Project 

• Modify Project 

• Delete Project 

• Project Merge Wizard 

Study Information Manager 
The Study Information Manager you maintain an electronic “audit trail” to process notes on 
research design, sampling techniques, coding guidelines, the emerging theoretical design, and 
analytical strategies and decisions made (3).  Memo fields for provided to support descriptive 
explanations about the overall Study.  

Researchers can use the Study Information Manager to document:  

• Study design and research objectives 

• Data collection methods, sampling techniques, data management and preparation 
procedures 

• Data analysis plan, including data reduction strategies, coding plans, time lines, and coding 
conventions for ensuring systematic data analysis, including procedures for assessing intra or 
intercoder agreement 

• Problems, biases, or Study limitations 
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Note: User-defined fields can be created using the Advance Study Utility located under File/System 
Utilities. 

New Project  
The New Project feature initiates the Project Wizard so that a new Project can be created under the 
active Study. 

Open Project 
The Open Project feature opens an existing Project. The Project need not be associated with the 
active Study. When you select a Project under another Study, the appropriate Study is activated. 

1. To open a Project, click on the plus sign (+) next to the Study name 

 
2. Select the Project to open. 

3. Check Force Resyncing of Project with Study before opening. The system keeps 
Projects synchronized (“in sync”) with the Study. If the system detects that a Project is no 
longer synchronized (“out of sync”) with the Study, it will adjust (i.e., update) the Project to 
the Study before it is opened. 

Note: Projects under password-protected Studies cannot be opened using this feature. To open a 
Project under a password-protected Study, use the Change to Another Study option.  

Modify Project 
The Modify Project feature initiates the Project Wizard.  All changes to the Project description and 
textual data are completed through the Project Wizard. The Project Wizard is also accessible via the 
Coding Editor by clicking the Add Files button. Typical Project modifications include: 
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Adding a New Text File  
1. Click the Add File to Project button. 

2. Select the type of file to add (i.e., TXT/RTF or Direct Text File). 

3. Clickthe Apply button. 

4. Use the pop-up browser window to locate a plain text (.TXT) or rich text file (.RTF) to add 
to the Project and click the Add File button. 

5. For direct text files, type in or paste the textual data and click the Save button. 

Note: Only plain text (.TXT) or rich text (.RTF) files can be added using the Modify Project feature. 
HTML files can only be added via the Coding Editor.  

A message box to process the file through the Sensitive Phrase Substitution (SPS) function will 
display. The SPS feature replaces confidential or sensitive data contained in a text file. For example, 
if a file contains a person's name (e.g., John Smith) and it is preferable not to have this individual's 
name appear in the text file, a pre-defined substitution phrase is applied. This option is only selected 
if substitution text has been previously entered via the Sensitive Phrase Substitution Administration. 
Upon selecting this option, a browser window will display. You must provide a new file name and 
click the New File button. 

To create a SPS database to process text files against: 

1. Go to the File menu and select the System Utilities submenu. 

2. Click on Sensitive Phrase Substitution (SPS) Administration or press [CTRL] + [P]. 

3. Click on the yellow folder icon   to add a new SPS record. 

   

4. Enter sensitive/confidential words or phrases contained in the original text files requiring 
replacement. 
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5. Type in the substitution phrase. 

6. Check on the Use exact case for phrase matching checkbox if the word/phrase is case 
sensitive. 

7. Ignore the Always print the substitution phrase on reports checkbox if SPS is being 
processed on text files as they are added to the Project. 

 

Note: A copy of the original file is made and a search/replace process is applied to the new file. The 
original file is not included in the analysis. 

If it is unknown beforehand what confidential or sensitive text requires replacement, you can 
perform SPS as you code in the Coding Editor. In this instance, coders/analysts always view the 
original text. Substitution text only appears in text-based output reports. 

Removing a File 
Removal of a text file results in deletion of associated source and textual coding from the 
project3.mdb file. Thus, make sure that a file is not needed before removing it. 

1. Select the desired file and click the Remove Selected File From Project button. 

2. Click Yes when the Confirmation Request window displays. 

3. A Deletion Confirmation window will display. 

Changing a File’s Location  
If the physical location of a TXT/RTF file has been changed, the file cannot be read in the Coding 
Editor. The file’s new location must be set using the Relocate Selected File from the Project Wizard. 

Note: AnSWR cannot be used to actually move a file. My Computer or Windows Explorer must be 
used to change the file’s location on your system.  

1. Select the desired file and click the Relocate Selected File button 
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2. Use the browser window to locate the files new location. 

3. Click the Open button. 

Note: If the folder, drive, or server location of all your Project files has changed, the new location 
can be set for all files by selecting the first file, clicking on the option to Relocate All Files, and 
then clicking the Relocate Selected File button. 

 

Setting File Alias to File Name  
1. Click the Set Alias for ALL Files to File Name button. 

2. Select the style to use when assigning an alias name: set to actual file name or set a prefix text 
string. The prefix string will be preceded by a system-assigned number that increases 
incrementally. 

 
3. Click the Set Alias File Name button 

Setting a File’s SPS Status  
If confidential or sensitive data will be replace as the coder/analyst performs the coding, the Study 
or Project Administrators can assign viewing rights to Project coders/analysts. By default, text-based 
output always prints substitution text rather than original text. Coder/analysts with viewing rights 
may print the original text. 

Note: SPS rights are Project and file specific.  SPS rights only apply to files that are processed while 
coding in the Coding Editor.  Text files that were processed through the SPS feature as they were 
added to the Project will always print the substitution word/phrase.  To view original text, 
coders/analysts would need to have access to these uncoded files. 
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Once a file has been set to use SPS, any coding will automatically check the SPS table and update the 
analysis tables with the SPS phrasing. Steps for setting SPS status are as follows: 

1. Select a text file. 

2. Click the Set File’s SPS Status button. The SPS File Utility Window is displayed. 

3. Activate SPS logic by checking the File should use SPS logic in analysis tables checkbox. 

4. Set coders/analysts that have SPS rights. At least one must be selected. 

5. Click the Apply button.  

Note: By default, text-based output always prints SPS text rather than the original text. Only 
Coder/Analysts with viewing rights may print the original text. 

Describing a File  
Because file names may not always help identify the contents of a file, AnSWR includes a feature 
that permits you to assign a brief description to a text file. 
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To enter the file description: 

1. Click on the text file you wish to describe. 

2. Click the View/Add/Save File Description or Alias button. 

3. In the File Description field, type in a brief description for the file. 

4. In the Alias Name field, type in a brief file name (up to ten alphanumeric characters). 
Note: The system automatically assigns TextDataMDB1.txt to the first direct text file. Only 
the MDB# will change in subsequent files. Files are numbered in the order in which they are 
added to a Project. Unless an alias file name is assigned to each direct text file, the 
TextDataMDB file name appears in the file list in the Coding Editor. Hence, it is strongly 
recommended that an alias be assigned to each direct text file. 

 
 

5. Enter a file date (optional). Clicking on the downward arrow displays a calendar.  
Note: The only date format accepted by the system is mm/dd/yyyy.  

 
6. Click the Apply button. 
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Converting a File 
To convert a TXT/RTF file into a direct input file: 

1. Click on the file you wish to convert. 

 
 

2. Click the Convert TXT/RTF File to Direct Input button. 

 
 

Note: A file can be process through SPS before being converted.  If this option is selected, a new 
text file that contains the SPS text is created. The original text file is not modified.  To activate this 
process, check the Process through SPS before conversion checkbox. Click the Process 
Conversion button. The system creates a direct text file and assigns it a TextDataMDB#.txt file 
name. 

Converting a Direct Input File into a TXT/RTF File 
1. Click on the file you wish to convert. 

2. Click the Convert TXT/RTF File to Direct Input button. 

3. Check  Process through SPS before conversion if applicable. 

4. Click the Process Conversion button. 

5. Enter a name for the new file. 

6. Select the file type. 
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7. Click the New File button. 

Re
t text files consecutively, you may want the files to be listed in 

 text file and click the Renumber Direct Text File button. 

the smallest number that can be assigned. 

numbering Direct Text Files 
Although the system numbers direc
the Coding Editor or on report output in another order. The Renumbering option permits you to 
assign a new number to your direct-entry text file.  Numbers already assigned to other direct text 
input files cannot be used. 

1. Select desired direct

2. Enter the new file number. 
Note: The system provides 

 
3. Click the Apply button. 

Delete Project 
ption, only the reference to a Project is deleted from a Study. As long as a 

rom the File menu. Deletion confirmation is displayed. 

No T ew Project from the File menu. When the Project 

he 

When selecting this o
Project is not physically deleted from a server or folder, it can be reintroduced at a later time. 

1. Open the Project to be deleted. 

2. Select Delete [Name] Project f

3. Click Yes to continue with deletion. 

te: o restore a deleted Project, choose N
Wizard prompts you for a Project name, enter the name of the Project you wish to restore. The 
Project name must be keyed in exactly as it was originally entered. If the location of Project 
TXT/RTF files has changed, use the Relocate Files option to update the pointer to these files. T
system will then reopen the Project and resynchronize it so that it is consistent with the most recent 
version of the Study. 
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Project Merge Wizard 
d to duplicate a Project, or to merge one or more Projects into a 

s where the volume of textual data is large or complex, we recommend splitting up the 

n existing Project: 

m the File menu.  

 

 

 

4. Accept the system default to Merge Selected Projects into a New Project Under 

The Project Merge Wizard is use
new Project or Study. Projects that are merged together share the same codebook/sourcebook 
structure.  

In instance
analysis into a number of smaller Projects. Once coding has been complete, these Projects can be 
merged and final data analysis and interpretation undertaken.  

Duplicate of a Project: 
To fully or partially duplicate a

1. Open the Project to be merged. 

2. Select Project Merge Wizard fro

3. Click the Next button. 

 

 

 

 

 

 

 

 

Current Study. 

 
5. Check the checkbox next to the desired Project as the Master Project.  

ave been source 
and text coded, uncheck the default option to Remove invalid text segments (segments 
with no codes or sources applied). 

6. If you have not run a quality assurance report to verify that all segments h

 
 

22



   

  
7. Click on the Next button. 

8. Enter a new Project name. 

 rt the duplication. 

 .  The log will list any information data. 

ssage will display.  Click the Yes button to synchronize the new 

9. Click the Next button. 

10. Click the Next button to sta

11. A merge log will display

12. Click on the Next button. 

13. Click on the Finished button. 

14. A Project Out of Sync me
Project with the Study. 

 
15. A File Conversion/Resync bar will display. 

Note: If you are duplicating a large Project, it may take a few minutes to complete this 
process. 

sociate all coding to the new Project.  
ject 

. Yes resets the coding origin to the newly created Project; No retains the original 

16. A message will display asking if you wish to as
Essentially, this is asking you if you would like to keep or delete retain the where the Pro
originated
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Project as the Master Project.  Because there is the potential that new Study code or
sources made be added to this the newly created Project, No is typically selected. 

 

 
17. A message indicating that the Project was successfully resynced to the Study will display.  

Click the OK button. 

Merge T s Under the Current Study 
To 

enu.  

ts into a New Project Under 

Note: The newly created Project becomes the active Project. 

wo or More Project
create a new Project out of one or more Projects: 

1. Open the Project to be merged. 

2. Select Project Merge Wizard from the File m

3. Click the Next button. 

4. Accept the system default to Merge Selected Projec
Current Study. 

5. Check the checkbox next to the desired Project as the Master Project. 

 
Note: If a Master Project is already checked, you must uncheck it before you try to check 
another Project. 

6. 

 

. 

8. Click on the Next button. 

Check the checkbox next to the Merge Project for each project that you want to merge 
with the Master Project. 

7. If you have not run a quality assurance report to verify that all segments have been source
and text coded, uncheck the default option to Remove invalid text segments (segments 
with no codes or sources applied)
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9. Enter a new Project name. 

Click the Next button. 10. 

 art the merge. 

 e log will list any information data. 

on to synchronize the new 

ync bar will display. If you are duplicating a large Project, it may 
ete this process. 

 you if you would like to keep or delete retain the where the Project 
Yes resets the coding origin to

ed Project, No is typically selected. 

Merge
To 

1. 

rge Selected Projects into a new Project under a new 

11. Click the Next button to st

12. A merge log will display.  Th

13. Click the Next button. 

14. Click the Finished button. 

15. A Project Out of Sync message will display.  Click the Yes butt
Project with the Study. 

16. A File Conversion/Res
take a few minutes to compl

17. A message will display asking if you wish to associate all coding to the new Project.  
Essentially, this is asking
originated.  the newly created Project; No retains the original 
Project as the Master Project.  Because there is the potential that new Study code or 
sources made be added to this the newly creat

18. A message indicating that the Project was successfully resynced to the Study will display.  
Click the OK button. The newly created Project will display in the AnSWR main window as 
the active Project. 

 One or More Projects into a New Project under a New Study 
take one or more Projects to create a new Project under a new Study: 

Open the Project to be merged. 

2. Select Project Merge Wizard from the File menu.  

3. Click the Next button. 

4. Click on the radio button for Me
Study.  

 
5. Check the checkbox next to the desired Project as the Master Project. 

Note: If a Master Project is already checked, you must uncheck it before you try to check 
another Project. 

6. Check the checkbox next to the Merge Project for each project that you want to merge 
with the Master Project. 
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7. I
a check the default option to Remove invalid text segments (segments 

. 

8. 

10. 

 

 start the merge. 

e log will list any information data. 

n. 

15. on to synchronize the new 

 bar will display. If you are duplicating a large Project, it may 
this process. 

 you if you would like to keep or delete retain the where the Project 
resets the coding origin to

ed Project, No is typically selected. 

Selec
A n e 
Project
networks.  Source data is selected from the Sources column. 

f you have not run a quality assurance report to verify that all segments have been source 
nd text coded, un

with no codes or sources applied)

Click on the Next button. 

9. Enter a new Study name 

Enter a new Project name. 

11. Click the Next button. 

12. Click the Next button to 

A merge log will display.  Th

13. Click on the Next butto

14. Click on the Finished button. 

A Project Out of Sync message will display.  Click the Yes butt
Project with the Study. 

16. A File Conversion/Resync
take a few minutes to complete 

17. A message will display asking if you wish to associate all coding to the new Project.  
Essentially, this is asking
originated. Yes  the newly created Project; No retains the original 
Project as the Master Project.  Because there is the potential that new Study code or 
sources made be added to this the newly creat

18. A message indicating that the Project was successfully resynced to the Study will display.  
Click the OK button. The newly created Project will display in the AnSWR main window as 
the active Project. 

t Data to Include in a Study/Project 
ew Project can be created using a subset of code, coders, sources, source data, or text files. Th

 Merge Wizard displays a merge column for textual files, coders, code networks, and source 

 
To select data to include in a merged Study or Project: 
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1. Check the column checkbox(es) for the data elements that you want to limit. 

Note: If data is to be selected from multiple Projects, the appropriate data element column must 
be checked for each Project. 

2. Click on the Next button. 

3. Enter new Project name.  Include a new Study name if a new Project is being created under 
a New Study. 

4. Click the Next button. 

 

7. 
xes.  Checked items are 

5. Click on the plus sign next to the Project name.

6. Click on the same line as the Project name.  A gray box contain three periods will display to 
the right of the Project name. 

 
Click on the gray box.  With the exception of the Source Networks, all data elements will 
display two options: check all checkboxes and clear all checkbo
included in the merge. Uncheck items are excluded from merge.  Clearing out all the 
checkboxes lets you manually check those items you would like to include. The Source 
Networks has a third option that will let you select records based on Source Demographics 
you entered using the Advance Source Utility. 

  
a. If you are selecting records using source data, select the Limit Using Source 

Demographics option. A Source Demographics Limits window will display. 

b. Select the desired field(s) and field values. 
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Note:  If you assigned categorical values to numeric fields, only the numbers will display
If necessary print a copy of the Advance So

.  
urce Utility Report under the Data/List 

Table Reports. 

 
c. Click the Apply button. 

d. Click the Next button. 

e. Repeat for each data element limitation you have selected for each Project and 
proceed with steps for completing a merge. 

View Menu 
The window can be changed to display a brief version of the Main Study Window. The brief view 
displays only menu options and the system icons. From the View menu, select View Brief Form to 
activate this view. To deactivate, select  again.  
 
 

View Brief Form
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Chapter 4:  
Working with Studies 
Open an Existing Study 
To open an existing Study from the AnSWR Study Manager Window, click on the down arrow in 
the Study Name field. This will display active AnSWR Studies. Select the desired Study from the 
dropdown list and click the Open Study button. 

 
Note: To change to another Study from the Main ANSWR Window (i.e., return to the Study 
Manager window), select Change to another Study from the File menu. 
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Delete Study 
To delete a Study:  

1. Select the desired Study from the Study Manager. 

2. Click the Delete Study button. 

Note: Only the reference to the Study is deleted from the system. To permanently remove the 
databases, use My Computer or Windows Explorer after deleting the Study from AnSWR.  

Re-Add a Deleted Study 
To re-add a previously deleted Study: 

1. Click on the New Study button. 

2. Type in the exact Study name as it was originally created. 

3. Click the Save button. 

Note: The main AnSWR Window rather than the Project Wizard will display.  

Help 
Click the Help button to access AnSWR Help. The Help file can also be accessed via the AnSWR 
Main Window, the Codebook Editor, the Sourcebook Editor, the Coding Editor, and the System 
Reports Manager. 

Exit AnSWR 
Click the Exit AnSWR button to close the system. The exit option can also be accessed via the 
AnSWR Main Window, the Codebook Editor, the Sourcebook Editor, the Coding Editor, and the 
System Reports Manager. 
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Chapter 5: 
The Codebook Editor 

 
Codes are assigned to the text during the coding process; AnSWR analysis uses code and source data 
to categorize text. The codes are stored in the Study Codebook. In AnSWR, codes are referred to as 
code networks given that a) the Codebook is a system or network of codes that have some 
relationship to one another and b) every code in the Codebook can be used to create a hierarchical 
code network.  Codes without a hierarchical structure are referred to as flat codes.   

The position a code holds within a code network will be important in applying codes and generating 
reports.  Each Project within a Study can use all of the Study code networks or use subset of 
selected code networks.  Hierarchical code networks can be created from the onset or constructed 
after coding as been initiated or completed.  The Analyzed Item Change Process option must be 
used to reassign codes already applied to a newly developed hierarchical network. 

Open Codebook Utility  
To open the Codebook Utility, choose Codebook from the File menu, or click the Codebook icon 
on the main AnSWR window. 

The Codebook Editor is split into two windows.  The left window displays all your Study codes, 
code networks that have been activated for use in the Project.  In the left window, you can perform 
the following: 

• Define and edit a Code Network. 

• Assign a Network Holder 

• Delete a Code Network from a Study (can only be deleted if it has not been applied in any 
Project). 

• Lock a Code Network Structure. 

• Globally change the name of a Study Code Network/Code Network Item. 

• Change application a selected Project Network Item to another Network Item. 
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The right window displays hierarchical code network trees, lets you define relationships between 
items in a code network, delete items from a code network, change the application of a selected 
Project code network to another network item, and determine if an item has been used. 

 

Add a New Codebook Network 
1. Open the Codebook Editor.  

2. Click the New Code button. A pop-up window prompts you to enter the New Code 
Network. 

3. Enter a new code network name up to 20 alpha-numeric characters in length, then click the 
Save button. Note: Code names greater than 20 characters in length will cause the system to 
crash.  Code names may not contain blank spaces or special characters (e.g., 
@#$%^&*?+><). Duplicate code names are not permitted.  

4. To add information for a new Code Network, select the Edit Network option from the 
Edit menu or by double-clicking on the code network name.  All of the Edit menu items can 
also be accessed by right-mouse clicking on a selected code.  

Important: If a Save button is displayed, it must be used to save information.  Failure to use the 
Save button will result in loss of data.  If no Save button is displayed, the system automatically saves 
the entry. 
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To use a Study Code Network in a Project, it must be activated.  Code Networks not activated will 
not display in the Code Network List in the Coding Editor.  Codes not appearing on this list 
cannot be applied to Project textual data. To add a network to the Project: 

1. Open the Codebook Editor.  

2. Click the checkbox next to the desired network under the network list. A check mark 
indicates that the network and all of its network items have been assigned to the current 
Project.  To simultaneously activate all Study codes into the current Project, enter [CTRL] 
+ [A]. 
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Edit a Codebook Network 
1. Open the Codebook Editor.  

2. Right-click on the desired code network under the network list. A pop-up menu opens. 

3. Select the menu option Edit Network or double-click on the code network name. The 
Code Network Edit Window is displayed. 

4. Enter the desired information for the code network. Use the tabs to move through code 
network data fields: Description, Usage, Example, Values. 

5. Click the Save button to save any changes or additions.  

To assist the coder/analyst in creating coding categories that are distinct from one another, AnSWR 
uses a codebook structure that contains six basic components: the code, a brief definition, a full 
definition, explanations for when to use the code, guidelines for when not to use the code, and 
examples.  For analytical flexibility, coding schemes can be developed a priori, a posteriori, or as part of 
an iterative process.  In addition, non-coded text segments can be created, reviewed, and have codes 
attached to them later. 
 

• The Brief Definition is a one-line, quick reference explanation of what the code represents.  
The brief definition can be a maximum of 50 characters in length. 

 
• The Full Definition is a detailed, expanded explanation of what the code represents.  The 

full definition does not have any field length limitations. 
 

• When to Use is a detailed code application statement (i.e., inclusion criteria).  We suggest 
guidelines include linguistic cues that may assist the coder/analyst in applying codes.  In 
addition, it is recommended that the When to Use explanation provide clear directions on 
whether concepts or ideas must be explicitly stated by a source or if they can be implicitly 
inferred by the coder/analyst. 

 
• When Not to Use is a detailed explanation of when the code should not be used (i.e., 

exclusion criteria).  We suggest that exclusion items provide some reference note for codes 
that fit the application criteria for an item.  For example, to help coders/analysts find the 
appropriate code or set of codes that better fits the exclusion criteria, codes can be placed in 
brackets or parentheses immediately after the listed item. 

 
• Examples are selected text excerpts where the code is applicable. 
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Note: The Values tab is not activated until the box for Code Network Uses Value Structure is 
checked.  Values can be -99 to 99.  Zero cannot be used. 

 
The Lock Code is available only if the user/analyst has Study Administrator rights. 

Add a Network Item to a Network 
1. Select a network on the Network List. The current network structure for the selected code 

will be displayed under Network Layout. 

2. Select the Network Item under Network layout in which to assign the new Network Item. 

3. Select the desired network from the network list to add as a network item by clicking the 
network and holding down the left mouse button. Important: Do not release the mouse 
button. 

4. The pointer will change to Drag mode. Drag the network over the network layout and drop 
it by releasing the mouse button. 
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5. The network and any underlying network structure will be added as new network items to 
the displayed network. 

 
Note:  In the display above, DelayImpact, DelayProblems, and DelayRecommend are Network 
Items under the Code Network DELAY_REFUSE_TX.  The Code Network 
DELAY_REFUSE_TX has been setup as a Network Holder (right-mouse click on the code name 
to get this option).  When a code network is designated as a Network Holder, it cannot be applied 
to the text.  The Network Holder feature permits you to group a set of codes that may have an 
abstract or theoretical relationship.  This relationship between codes is implicitly understood by all 
coders/analysts.  The Network Holder is used to group related codes for coding ease. The system 
will display the small folder icon under the network list in purple for networks that have been set as 
Network Holders.    

Note: Because DELAY_REFUSE_TX has been activated, all network items are also activated. If 
coders/analysts are only to apply Network Items from either a Network Holder or Code 
Network, the check boxes for these codes should not be marked. 
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Delete a Network Item 
1. Select the desired code network from the network list. 

2. Select the desired code network item from the network layout. 

3. Right click on the desired code network item. A pop-up menu is displayed. 

4. Select the menu option Delete Item from Network or enter [CTRL] + [F]. 

5. The code network item and any underlying items in the network structure will be deleted. 

 
Note: If any Network Item has been assigned to a text segment under any Project in the Study, the 
network item deletion process will stop. A message box will display indicating which Project has 
used the network item in coding. 
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Delete a Code Network from a Study 
1. Click on the desired code network to select it, then click Edit, or right click on the desired 

network under the network list.  

The Edit menu is displayed. 

2. Select the menu option Delete Network from Study or enter [CTRL] + [D]. 

3. A confirmation box is displayed. Confirm the delete action and the network will be deleted 
from the Study. 

Note: If the network or any of its network items have been assigned to a text segment under any 
Project under the Study, you will be unable to delete the network. A message box is displayed 
indicating why the network deletion was stopped. 

 

Delete a Code Network from a Project 
1. Click on the desired code network to select it, then click Edit, or right click on the desired 

network under the network list. The Edit menu is displayed. 

2. Click the checkbox next to the desired network under the network list. 

3. The check box will be blank indicating that the network and all of its network items has been 
removed from the current Project. 

Note: If the code network or any of its network items have been assigned to a text segment in the 
current Project, the action will be stopped. 

Import Codebook from Another Study 
If no sources and no codes have been added to the current Study, the system allows you to import 
the codebook and sourcebook from another Study. Studies that share the same 
Codebook/Sourcebook structure may be merged using the Project Merge Wizard. 

1. Open the Codebook Editor. 

2. From the Utilities menu, select Use a Codebook and Sourcebook from another Study. A 
window is displayed with a drop-down list of Studies.  

3. Select the desired Study and click the Import button, or click Cancel to abort.  
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Note: Use the AnSWR Code Source Utility to import sources and codes from another Study if the 
Codebook is not empty. The AnSWR Code Source Utility should also be used if coders have 
independently added new codes to a shared study. 

Import/Export Tally or EZ-Text Codebook 
AnSWR will let you import codebooks from two other software programs: Tally, an MS-DOS 
program, and EZ-Text, a Windows-based CDC developed program designed specifically for surveys 
containing a large number of brief, open-ended questions. 

 
1. Open the Codebook Editor. 

2. From the File menu, select Import/Export Tally or EZ-Text Codebook  

3. Select the type of codebook to import or export. 

4. Select the desired process---to import or to export. 

5. If a codebook is imported and both codebooks contain the same code network labels, you 
can have the system leave out duplicate items by checking the Automatically skip codes 
that duplicate a code already in Study codebook checkbox.  

6. Click the Continue button. 
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Chapter 6: 
The Sourcebook Editor 
The Sourcebook Editor is opened from the main AnSWR window by clicking on the Sourcebook 
icon or selecting Sourcebook Editor from the File menu. 

 
A text segment must contain a source and a code to valid. The AnSWR analysis uses code and 
source data to categorize text. The source networks are written to the Sourcebook. Each Project 
within a Study can use all of the Study’s source networks or use only a selected subset of source 
networks. 

Open Sourcebook Utility  
To open the Sourcebook Utility, choose Sourcebook Editor from the File menu, or click the 
Sourcebook icon on the main AnSWR window. 

Note: The Sourcebook Editor layout is very similar to the Codebook Editor.  The sole exception is 
that source networks are “defined” in the Advance Source Utility. 

Add a Sourcebook Network 
1. Open the Sourcebook Editor.  

2. To add a new Source Network to the Study, click the Add Source button. A pop-up 
window opens. 

3. Enter the new network code name or source ID, then click the Save button. 

4. To add information for a new Source Network, use the Advanced Source Utility. See 
Chapter 7 for Advanced Source Utility help. 
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To add a network to a Project: 

1. Open the Sourcebook Editor.  

2. Click the checkbox next to the desired network under the network list. A check mark 
indicates that the network and all of its network items have been assigned to the current 
Project. 

Add a Network Item to a Network 
1. Click on a network on the Network List. The current network structure for the selected 

code is displayed under Network Layout. 

2. Select the network under Network Layout in which you wish to assign the new network 
item. 

3. Select the desired network from the Network List to add as a network item by clicking the 
network and holding down the left mouse button. Do not release the mouse button. 

4. The pointer will change to Drag mode. Drag the network over the network layout and drop 
it by releasing the mouse button. 

5. The network and any underlying network structure will be added as new network items to 
the displayed network. 

Delete a Network Item 
1. Select the desired network from the network list. 

2. Select the desired network item from the network layout. 

3. Right click on the desired network item. A pop-up menu is displayed. 

4. Select the menu option Delete Item from Network or press [CTRL] + [F]. The network 
item and any underlying items in the network structure will be deleted. 

Note: If any network item has been assigned to a text segment under any Project in the Study, the 
delete process will stop. A message box will indicate which Project uses the network item in coding. 

Delete a Source Network from Study 
1. Click on the desired network to select it, then click Edit, or right click on the desired 

network under the network list. The Edit menu is displayed. 

2. Select the menu option Delete Network from Study or press [CTRL] + [D]. 

3. A confirmation box is displayed. Click Yes to delete the network from the Study. 

Note: If the network or any of its network items have been assigned to a text segment under any 
Project under the Study, you will be unable to delete the network. A message box will indicate why 
the network deletion was stopped. 

Delete a Code/Source Network from Project 
1. Click on the desired network to select it, then click Edit, or right click on the desired 

network under the network list. The Edit menu is displayed. 

2. Click the checkbox next to the desired network under the network list. 
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3. The checkbox will be blank, indicating that the network and all of its network items has been 
removed from the current Project. 

Note: If the network or any of its network items have been assigned to a text segment in the current 
Project, the action will be stopped. 

Import a Sourcebook from Another Study 
If no sources and no codes have been added to the current Study, the system allows you to import 
the codebook and sourcebook from another Study. Studies that share the same codebook and 
sourcebook structure may be merged using the Project Merge Wizard. 

1. Open the Sourcebook Editor. 

2. From the Utilities menu, select Use a Codebook and Sourcebook from another Study. A 
window opens with a drop-down list of Studies.  

3. Select the desired Study and click the Import button, or click Cancel to abort.  

Set the Default Source  
Each Project may be assigned a default source. Unless another source is specified, the system will 
source code all text segments with "AnSWR". 

1. Go to File/Modify Project. 

2. The Project Wizard will display.  Click the Next button. 

3. Check the Always Apply Default Source When Coding box. 

4. Continue to click the Next button until the Project Wizard Finished window displays. 

5. Click the Finish button. 

 
Note: The Project default source can be changed in the Coding Editor.  However, the new default 
must be added to the Sourcebook Editor before this change can be made. 
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1. From Coding Editor's Tools menu, select Coding Tools, then select View/Change 
Default Source or press [CTRL] + [D]. The AnSWR Default Source Window is displayed 

2. The window displays the Project Default Source and the currently set Coding Default 
Source. Unless changed, the Coding Default Source will be set to the Project Default Source. 

3. To change the coding editor default source, select the desired source from the drop-down 
list and click Close. 

Set Temporary Default Source 
The Project default source may be temporarily set to a different source from the Coding Editor for 
the current Coding Editor session. 

1. From Coding Editor's Tools menu, select Coding Tools, then select View/Change 
Default Source or press [CTRL] + [D]. The AnSWR Default Source Window is displayed. 

2. The window displays the Project Default Source and the currently set Coding Default 
Source. Unless changed, the Coding Default Source will be set to the Project Default Source. 

3. To change the coding editor default source, select the desired source from the drop-down 
list and click Close. 

 
Note: If each text file is associated with a different default source, a new default source must be set 
when segmenting and coding a new text file. 
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Chapter 7:  
Advanced Source Utility 
Use the Advanced Source Utility to add or update source data. The utility allows for the addition of 
user-defined fields to the source table and the building of a custom data entry form. To reach the 
Advanced Source Utility, select System Utilities from the File menu, then select Advanced Source 
Utility.   

The Advance Source Utility is divided into three windows. 

• Data fields 

• Source Utility function keys 

• Form page 

 
Important: To enter source data, fields (i.e., variables) must be placed on the Form entry page. 

The top of the window lets you move to a previous or next source network by clicking on the back 
and forward buttons.  A dropdown option to the far right of this tool bar lets you scroll through 
your list of source networks to jump to that source’s data. Alternatively, you may type in the sources 
ID label. 

 
Note:  New sources cannot be added from the Advance Source Utility.  They must be added from 
the Sourcebook Editor. 

The bar across the bottom of the Advance Source Utility window, tells you what Form page you 
are on and the source. 
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The Source Utility function keys are: 

 
Add a field to the source data table 

 
Permanently delete a field from the source data table 

 
Move back one form page 

 
Move forward one form page 

 
Automatically add a field to a form 

 
Help file 

 

Add Fields to Table 
A field is limited to eight alpha-numeric characters in length.  If source data will be exported for 
using in a statistical program, a field name should never begin with a number.   

1. On the Advanced Utilities window, click the Add a New Data Field to Table button. The 
Data Field window is displayed. 

 
2. Enter the Field Name and specify the data type (Text, Numeric, Date, Memo, or 

Yes/No-True/False).  

3. Specify the field size, if applicable. 

4. Click the Save Field button.  
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Note: A text field may contain no more than 255 characters.  A memo field is not limited in size. To 
create categorical response items, create a numeric field.  See page 48 for help on how to Build 
Field Value Structure. 

Delete Fields from Table 
This option permanently deletes the field and any source data stored in the study30.mdb data tables. 
Once deleted, a field cannot be retrieved.  To restore fields that have been deleted from the data 
tables, the field must be recreated and data re-entered.  A field can be deleted from the Form, 
without deleting the field from the source data tables. To only Delete Field from Form, see page 
47 for help. 

 
1. Click the Delete Selected Data Field button. 

 

 

 

2. A deletion confirmation prompt will display.  Click the Yes button to permanently delete the 
field.  No will cancel the process. 

 

Add Field to Form  
To add fields automatically:  

1. Click on the data field to add to the form.  

2. Click the Add Field to Page button.  

 
3. The Caption window is displayed. 

4. Enter the desired caption for field. 

5. Click the Close button. The field appears on the last page of the form with the format 
appropriate to the type of field. 
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To add fields manually: 

1. Select the desired field. 

2. Right click on field and drag to page. 

3. Drop field on desired position on page.  

Delete Field from Form  
1. Right click of the caption/label for the desired field on the form. 

2. From the popup menu, select Delete Field menu option. 

Change Field Position on Form  
1. Click and hold down mouse button on the caption/label for the desired field on the form. 

2. Drag field to desired position on page. 

3. Release the mouse button to drop field in new position. 

Note: Fields may not be moved from page to page. 

Resize Field on Form  
1. Right click on the caption/label of the field to resize. 

2. From the popup menu, select Modify Width menu option. The Modify Field Size window 
is displayed. 

3. Select to enlarge or reduce field and the desired percentage. 

4. Click the Apply button. 
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Build Field Value Structure 
Numeric-type data fields may be assigned a value structure. Important: The value structure must be 
created before the field is placed on the Form.  

For example, for a data field called Race, you may want to assign a value structure of: 

1 = White  2 = Black  3 = Hispanic  4 = Other 

Click a data field to select it and click the Add/Edit/View Value list for [Field] option from the 
Edit menu, or select field by double clicking on it. The Field Value Set window is displayed.  

1. Double-click on the numeric field 

2. Click the New Value button. 

3. Select a value for the field from drop-down list. 

4. Enter a value description. 

5. Click the Save button. 

6. Repeat for each value. 

 
To edit an existing field value:  

1. Click value to display dropdown list. 

2. Select new value from list. 

3. Click the Save button. 

To edit an existing value description:  

1. Click the description to highlight it. 

2. Enter the new description. 

3. Click the Save button. 

To delete a field value: 

1. Click the desired value. 

2. Click the Delete button. 
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Note: Value structures already placed on the Form cannot be modified or deleted.  Changes should 
be made before the field is placed on the Form.  If changes need to be made, after they have been 
placed on the Form, they must be deleted and re-added.  

Add Labels to Form  
Labels such as form titles or instructions for a field may be added to a form. 

1. Click the field item Form Label. The Caption window is displayed. 

2. Enter the desired caption for field. 

3. Click the Close button. The label appears on the last page of the form. 

Associate External Files 
You can store a list of related files with a Study or Project.  External files can also be associated with 
a specific source.  For example, you can link .WAV files containing a source’s digitally recorded 
interviews, photograph, family tree, etc. 

1. Click the External Files button in the utility toolbar. The External File Utility window is 
displayed. 

2. Click the Add New External File to: Source - AnSWR button. 

3. From the Open pop-up window, select the desired file. 

4. Click the Open button. 

5. Enter a description for the file. 

 
To add a URL: 

1. Click the Add New HTML URL to: Source - AnSWR button.  

2. Enter the URL when prompted. 

3. Click OK. 

To open an associated file:  

1. Click on the desired file to select it. 

2. Click the Open Selected External File button. 
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To modify a file description: 

1. Click on the file to select it. 

2. Click the Add/Modify Description button. 

3. Make the desired changes to its description. 

4. Click the Apply button. 

To delete an external file: 

1. Click on the file to select it.  

2. Click the Delete External File/URL from: Source - AnSWR button. 
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Chapter 8:  
The Coding Editor 
Layout 
The Coding Editor Window contains the tools needed to code text and HTML files.  The Coding 
Editor is divided into three permanent windows and a fourth window that can be closed and 
reopened at anytime. 

 

 

 

 

 

 

 

 

 

 

 

The three permanent Coding Editor windows are: 

• The text window displays the active text file.  

• The processing window.  Depending on the process, this window’s contents will change.  
Each process has an icon to activate the window’s contents. The three processes are: 

 

 
When a text segment is created, the system automatically assigns a 
Segment ID. 

Segment IDs reflect the order in which the text segment was 
created rather than the text’s position on the page relative to other 
text.  Clicking on a Segment ID on the list opens the 
corresponding file and highlights the text segment.  Alternatively, 
clicking on the text that has been coded will activate the text 
segment. 
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When you click on the Source Networks icon, the window 
changes to display a list of all source networks assigned to the 
Project.  

When you select a text segment ID that has already been source 
coded, the source(s) applied to the segment are moved to the top 
of the list and displayed in a turquoise blue colored font.  

The folder icon next to the source network name indicates whether 
the source network has an underlying network. If the folder icon 
contains a (+) sign, then the source network has an underlying 
structure. Double click the source network to view the source 
network structure and assign source network items to the coded 
text segment. 

 

 
When you click on the Code Networks icon, the window changes 
to display a list of all the code networks assigned to the Project. 

When you select a text segment ID that has already been coded for 
content/topic, the code(s) applied to the text segment are moved 
to the top of the list and displayed in a turquoise blue colored font. 

The folder icon next to the code network name indicates whether 
the code network has an underlying network. If the folder icon 
contains a (+) sign, then the code network has an underlying 
structure. Double click the code network to view the code network 
structure and assign code network items to the coded text segment.

 

• The text file window.  All files associated with the Project are listed in this window.  If alias 
names were assigned to text files, an alphabetically listing of these names is displayed.  If no 
alias name was assigned to Direct Text Input files, an alphabetical listing of all of the 
textdata#.mdbs is displayed.  

   
 

The fourth window is the Family ID Information Window, which contains coding information 
about the active text segment ID. The window displays code networks, source networks, 
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coder/analyst, and the unique ID number for the coded segment. The default view only displays 
source networks, coder/analyst and the unique ID number. Use the View menu options to 
determine which elements to display in the information window. 

 
The top tool bar of the Coding Editor displays the active Study and Project. 

 
The bottom tool bar of the Coding Editor displays the active file’s alias name if different from the 
file name.  It also displays the active coder and line information. 

 
After a text segment is created, the tool bar displays position and active text segment ID 
information. 

 
Other features available in the Coding Editor include: 

• The Shortcut Key Window, which displays a list of keyboard shortcuts and symbol 
definitions used in the coding editor. Use the View menu option to display the window, or 
press [CTRL] + [K] 

• Cue Cards, which provide quick directions for coding text segments. Cue cards are displayed 
each time the Coding Editor is accessed. To stop cue cards from starting automatically, 
uncheck the Show Cue Cards at Startup option in the Cue Card window. Cue cards may 
be opened at any time from the Help menu by selecting the Cue Cards option. 

• Access to both the Codebook Editor and the Sourcebook Editor.   

Preferences  
The Preferences Utility is used to set the default text properties display of text files, to turn off 
selected system confirmation messages, and to set Word Count preferences. 

1. From the Coding Editor Tools menu select Preferences, then Editor Options. The Coding 
Editor Preferences window is displayed.  

2. To close the window, click the Close button.  
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General Preferences 
General Preferences control whether selected confirmation messages are displayed. The system 
default is to display all messages. 

To set general editor preferences: 

1. Click the General tab to display the options.  

2. Click the checkbox for any option you wish to select or deselect.  

3. Click Apply to lock in any changes 

Font Preferences 
Font preferences set here are used to display all files. To set font preferences: 

1. Click the Font tab to display options.  

2. Click Select Font button to set font, style, and size. 

3. Click the checkboxes for any option you wish to select or deselect. 

4. Click Apply button to lock in any changes. 

Note: To change font for the current session only, use the Set Font option under the Tools menu, 
Preferences option. 

Word Count Preferences 
To see whether Word Count is activated or to set the options Word Count should use:  

1. Click the Word Count tab. 

2. Click the checkboxes for any options you wish to select or deselect.  

3. Click Apply button to lock in any changes. 

Segmentation 
Coding in qualitative data analysis involves carefully reading through the textual data; identifying 
ideas about viewpoints and things experienced, heard, or seen; and creating a code to help mark 
similar data, and then assigning a code to like data. 

Before you can actually code the textual data, you must first identify what text to code.  This process 
involves breakdown the text into meaningful chunks or segments (7). Text segments can be broken 
down into subunits, called embedded or nested text segments, provided that theoretically a distinct 
context and meaning is preserved.  

A text segment is can be a word, phrase, sentence, paragraph, or an entire document.  If a word or 
phrase is the unit of observation or the intent is to perform a traditional content analysis, it is 
recommended that the Word Count feature be used. 

 
 

54



   

The boundaries of the text segments are defined by the coder/analyst.  There are four types of text 
segments that can be created.   

• Individual – stands apart from other text segments 

• Nested/embedded – contained within a large text segment 

• Overlapping – allows cross-over between two or more text segments 

• Linked segments located in different parts of the text. See page 72 for help on linking coding 
family segments 

To preserve the relationships between codes, text segmentation is based on a Coding Family 
Structure.  Text segments may contain nested/embedded text segment, which in turn can contain 
nested segments of their own; thus, creating generations of segments for a given family.  A parent 
segment is the largest, most inclusive segment.  Each family has its own unique ID.  All coding 
family members are assigned the same root ID as their parent segment (e.g., coded text segment 1).  
Nested segments are assigned a numeric generation value (e.g., coded text segment 1.1) to support 
greater flexibility in how coded data is analyzed and interpreted.  Text segments can be examined as 
exclusive, self-contained units or as inclusive, relational items. Overlapping segments form new 
families; hence, they are assigned their own unique family ID. 

 

 

 

 

 

 

 

 

 

 

 

There are two methods for creating text segments in AnSWR: 

• Highlight a block of text and click on the Create Segment button. This technique works 
best when you have a relative smaller chunk of text to segment.  
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• Place the cursor where you want the text segment to begin and click the Open Segment 
icon.  Scroll down to where you want the text segment to end and click the Close Segment 
button. This technique is optimal for larger text segments. 

   
When a text segment is created, the system displays the parent segment in maroon-colored text.  A 
different text font color is assigned each subsequent level of embedded segments.   

Modifying Text Segment Dimensions 

Modifying Dimensions of Coded Text Block  
The text assigned to a coded text segment may be modified by expanding or decreasing the start and 
end positions of the text segment. When expanding a coded text segment, the new text segment may 
not overlap another coded text segment (i.e., have the same start and end positions). When reducing 
a coded text segment, the new text segment must still include all offspring/child text segments.  If 
modification of text segment dimensions also requires modification of embedded segment, changes 
to the offspring/child segments should be made prior to changing the parent segment. 

1. Select the desired coded text. 

2. From Tools Menu – Coding Tools option, select Modify Text Segment or press [F11]. 

3. Select new text segment. 

Note: To cancel the Modify Text Segment process, press the [F12] key. 

Delete Text Segment 
To permanently delete an existing text segment: 

1. Click on the desired text segment ID or on the text to activate the segment ID. 

2. Click the Coded Segments button. 

3. Click the Delete Segment button. 

 
4. A confirmation message will display. 

5. Click the Yes button. 
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Source Coding  
It is necessary to identify which source or set of sources is associated with the textual or image data. 
This process is referred to as source coding. Source coding can be performed at two levels: file-
based and segment-based. Some Studies may involve use of both source-coding strategies.  

In file-based source coding, an entire text file is attributed to a single source or a set of sources. 
Examples of files where file-based source coding might be completed include: 

• Abstracts 

• Published articles 

• HTML documents 

• Graphic images 

In segment-based source coding, selected text is attributed to a source or set of sources. Examples 
of text files were segment-based source coding might be completed include: 

• Focus group interviews 

• Individual interviews 

Source coding can be performed manually by the coder/analyst using the drag and drop method, or 
completed by the system if default source coding has been activated.  When default source coding is 
used, source coding is automatically performed as the text segment is created. 

Important: AnSWR requires that each coded text segment be associated with at least one source. If 
no source has been applied to a coded text segment, the segment will not be included in analysis 
outputs.  Verify that the checkbox for Segment has Source(s) applied is checked for each text 
segment.  A Coding Ass gnment Report under the Quality Assurance Reports can also be used 
to identify text segments that have not been source coded. 

i

 
You can also use the Family ID Information Window to verify that the correct source has been 
applied to a text segment. 

 

Add Sources 
To add source networks with no network structure:  

1. Display the Source Network List by clicking the Source Networks button. 

2. Select source network from source list. 
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3. Click on selected source network and hold down left mouse button. 

4. Drag and drop source network over highlighted text segment. 

5. Repeat until all source networks have been assigned. 

To add source items from a network structure: 

1. Display the Code Network List by clicking the Source Networks button. 

2. Double click on desired source network. The network structure for the source network is 
displayed. 

3. Select the source network item desired. 

4. Click the Add Network Item to Family button. 

5. Repeat until all source network items have been assigned. 

6. Click the Close Network Tree button. 

Delete Sources 
To remove a source from an existing coded text segment: 

1. Click on the desired text segment ID or the text to activate the segment ID. 

2. Click the Source Networks button 

3. Select the desired source to remove. 

4. Click the Delete Source button. 

 
5. A confirmation message will display. 

6. Click the Yes button to permanently delete the source from the coded text segment. 

 
7. Repeat until all desired sources have been removed. 

Delete Sources from Network 
To delete source items from a network structure: 

1. Click on the desired text segment ID or on the text to activate the segment ID. 

2. Display the Source Network List by clicking the Source Networks button. 

3. Double click on desired source network. The network structure for the source network is 
displayed. 
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4. Select the source network item desired. 

5. Click on the Delete Network Item to Family button. 

6. Repeat until all source network items have been assigned. 

7. Click the Close Network Tree button. 

 

Text Coding  
Text coding refers to the process of assigning codes to a text segment. A text segment may contain 
multiple codes.  AnSWR requires that each text segment contain at least one code.  If no code has 
been applied to a source coded text segment, the segment will not be include in analysis outputs.  
Verify that the checkbox for Segment has Code(s) applied is checked for each text segment.  A 
Coding Ass gnment Report under the Quality Assurance Reports can also be used to identify 
text segments that have not been text coded. 

i

 
Text coding can be added immediately when the text segment is created or by selecting an existing 
text segment.  You can use the Family ID Information Window to verify that the correct codes 
have been applied to a text segment. 

 

Add Codes 
To add code networks with no network structure:  

1. Select code network from code list. 

2. Click on selected code network and hold down left mouse button. 

3. Drag and drop code network over highlighted text segment. 

4. Repeat until all code networks have been assigned. 

To add codes from a network structure:  
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1. Double click on desired code network. The network structure for the code network is 
displayed. 

2. Select the source network item desired. 

3. Click on the Add Network Item to Family button. 

4. Repeat until all code network items have been assigned. 

5. Click on the Close Network Tree button. 

 

Delete Codes 
To remove a code from an existing coded text segment: 

1. Click on the desired text segment ID or the text to activate the segment ID. 

2. Click on the Code Networks button 

3. Select the desired code to remove. 

4. Click on the Code Options button. 

 
5. Click on the Delete Code from Segment item. 

6. Click on the Apply button. 
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7. A confirmation message will display. 

8. Click the Yes button to permanently delete the code from the coded text segment. 

 
9. Repeat until all desired codes have been removed. 

Delete Codes from Network 
To delete code items from a network structure: 

1. Click on the desired text segment ID or on the text to activate the segment ID. 

2. Display the Code Network List by clicking Code Networks button. 

3. Double click on desired code network. The network structure for the code network is 
displayed. 

4. Select the code network item desired. 

5. Click the Delete Network Item to Family button. 

1. Repeat until all source network items have been assigned. 

2. Click on the Close Network Tree button. 

Clear Source/Text Coding  
To clear coding for an entire file:  

1. Display the text file. 

2. From Tools Menu – Coding Tools option, click Clear Source/Text Coding. A Clear 
Source/Text Coding window opens.  

3. Select desired option for clearing existing source and coding data 
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4. Click the Apply button. 

 
Note: This is a permanent deletion.  Source and/or text coding are removed for all coders/analysts 
in the active Project.  Once sources and/or text coding are cleared, the system cannot undo the 
process. 

Adding Files to Project 
TXT and RTF files can also be added in the Coding Editor.  Click the Add File button on the 
toolbar to open Project Wizard. 

 
Note: HTML files are added using the Coding Editor browser window.  
 

HTML Coding  
When coding HTML documents, it is highly recommend that Direct Text Entry be utilized.  By 
using direct text entry for HTML all of AnSWR's coding options are accessible and changes in URL 
addresses or website content do not negatively impact the analysis. To activate HTML go to the 
Main AnSWR Window and go to File/Preferences.  Under the CODING EDITOR STYLE, 
remove the check mark from the Use Editor without HTML access. 
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In the Coding Editor, press the [F4] key to switch to HTML mode, or use the HTML Coding 
option under the Tools menu. Any type of file that can be opened under Microsoft Internet 
Explorer can be displayed and coded in the coding editor browser. 

 
Enter the URL address and click on the Add File button.  Open the Project Wizard to set Alias 
name or SPS status. 
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Note: The HTML mode requires Microsoft Internet Explorer 6 or greater. 

Again, when coding HTML documents, it is recommended that Direct Text Entry be used so that 
all of AnSWR’s coding options can be utilized. For better data control and analysis flexibility, use the 
direct text method to add data from Web pages (see below). 

Directly Code HTML Documents 
1. Go Tools/HTML Coding. 

2. Click on down arrow in Address field to display URL. 

3. Select the desired text. 

4. Right click on selected text and click Copy. 

5. Click the Select Segment button. 

6. Add desired source network and code networks to be assigned to text segment. 
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Code HTML Documents Using Direct Text Entry 
1. Open the desired HTML document in any Internet browser. 

2. Select and highlight the desired text. 

3. Right click on selected text and click Copy. 

4. Open the Direct Text Entry window in the AnSWR Coding Editor by pressing [CTRL] + 
[T]. 

5. Paste the captured text into the Direct Text Window by pressing [CTRL] + [V]. 

6. Code as for any regular text file. 

Code Graphics  
Graphics are coded in HTML mode Graphics may be of any type that is recognized by the browser, 
such as JPEG or GIF format. Graphics may be coded a part of a HTML document or directly. 

Graphic files must be saved locally in order to code them in AnSWR. 

1. Right click on desired graphic in the HTML document and click. 

2. Select Code Graphics/Sound file from Tools menu/HTML. 

3. Locate the saved graphic file. 

4. Add desired source networks and code networks to be assigned to the coded graphic file. 
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Code a File  
Text Coding may be applied to an entire file. Text coding for an entire file may be applied only one 
time. Source coding for the file must be completed before file coding. 

1. From Tools – Coding Tools menu, click Code a File. 

2. Add Code Networks as you would for text coding. 

Use Word Count  
When word counting is active, the system automatically triggers the word count process when a top-
level family is coded. Word counting process can be triggered on demand in two ways: 

1. Select desired text segment and press [CTRL] + [W] to recount words. 

2. Press [CTRL] + [Y] to display existing word count info for segment. 

Word Counting for the Entire Study 
1. In the Main AnSWR window, go to the File menu, then select Menu. 

2. Select System Administration and click on the Study Administration tab. 

3. At the bottom of the Administration window, check the Force All Projects to process 
Word Counts. 

4. If you wish to use the Word Exclusion or Word Alias Lists, select the checkboxes next to 
those options. 

5. Click Apply Study Word Count Settings. 

6. Click Close. 

Word Counting for the Current Project Only 
All coded segments in a Project may be word counted at one time. This process takes a long time to 
complete and requires user intervention. The process may be stopped and restarted later. 

To start the process: 

1. From the Coding Editor Tools menu, select Word Count Tools, then select Project Word 
Count. A dialog box opens, informing you that the process will take several minutes and 
asking if you wish to continue.  

2. Click Yes to continue or No to abort.   

3. During the word count, AnSWR identifies segments that have already undergone the word-
count process. For each, you may see the decision box: 
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4. Choose an option and click the Apply button. 

Note: When stopping a process, click the button only one time. The process will stop or restart 
after the completion of the current segment.  

Word Counting Process 
The word count process is automated but requires your input. During the process, AnSWR displays 
several dialog boxes.  

Handling Alias Words  
Words that are members of only one alias list are automatically assigned to the master word for that 
list. When the Use Alias Word List preference is turned on, the system stops when a word is in 
more than one alias list. Several options are possible for assigning the word in question. 

 
1. Select the desired option. 

2. Click the Apply button. 
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3. To view the text segment containing the word in question click the View Text Section 
button. 

Word Count Results  
When the system completes the counting process, the Word Count Results window is displayed. 
The window displays by source ID the words and the count for each word. 

You can make adjustments to word count by deleting words or assigning one word to another word. 

To delete a word, just uncheck the word. 

To reassign one word to another word: 

1. Select word to reassign. 

2. Hold down mouse button until drag icon appears, then release.  

3. Move cursor over word to assign to and click the mouse button. 

Search Options  
AnSWR allows you to search by text string, segment ID, code or source. 

Text Search  
1. From Tools menu, select Find, then select Text Search  or press [F6]. The Text Search 

window opens. 

2. Enter desired text and click the Search button. 

3. Press [F6].to move to next occurrence.  

Unique ID Search  
1. From Tools menu, select Find, then select Unique Text Segment, or press [F7]. The 

Unique ID Search window opens. 

2. Enter desired unique ID and click the Go button.  

Code Search  

Find Code Network or Network Item with No Underlying Structure  
1. Click desired code network from Code Network List. 

2. Click the Code Options button. 

Find Code Networks with Underlying Network Structure 
Double click desired code network to display Network Structure window.  

1. Select desired network item. 

2. Click the Code Options button. 

Find and D splay Coded Text Segment  i
1. Click the whether to include all files or the current text file in the Code Options window. 

 
 

68



   

2. Click the Apply button. The Code/Source Search Toolbar is displayed. 

3. Use the Code/Source Search Toolbar to move between occurrences. 

Find and D splay File with Codes Applied  i
1. From Code Options window, choose whether to include files with coding not completed or 

all files.  

2. Click the Apply button. The File Selection window opens.  

3. Select the desired file and click Open File. 

Source Search  

Find Source Networks with No Underlying Structure 
1. Click desired source network from Source Network List.  

2. From Tools menu, select Find, then select Source Search or press [F9]. 

Find Source Networks with Underlying Network Structure  
1. Double-click desired source network to display Network Structure window.  

2. Select desired network item. 

3. Click the Source Options button. 

Search and Display Coded Text Segment  
1. Choose whether to include all files or current text file only in the Source Options window. 

2. Click the Apply button to save your selection and display the Code/Source Search toolbar. 

Use the Code/Source Search toolbar to move between occurrences. 

Search and Display File with Codes Applied  
1. Click the whether to include files with coding not completed or all files from Source Options 

window.  

2. Click the Apply button. The File Selection window is displayed. 

3. Select the desired file and click Open File button. 

Quick Jump 
To jump to a specific item on the Coded Text list, Code Network list, or Source Network list, use 
Quick Jump. 

1. Press [CTRL] + [Q]. The Quick Jump window opens. 

2. Select desired jump type and enter what to jump to. 

3. Click Quick Jump. 
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Moving Around a Text File  
1. From Tools – Find menu, select Go to Line or press [F5]. The Line Select window is 

displayed. 

2. Enter desired line number and click Go to Line. 

Adding Notes  
Coder/analyst notes or memos can be assigned to a coded text segment or to an entire Project. 

Add/Edit Segment Notes  
1. Select coded text segment. 

2. From the Tools menu, select Coding Tools, then select Coding Notes or press [F2]. The 
Notes Utility window opens. 

3. Enter or modify the text notes in the Segment Notes tab. 

4. Click Process Segment Analysis Note to save changes or Close to exit without saving. 

 

Adding/Editing Coder/Analyst Process Notes  
1. Select any coded text segment. 

2. From the Tools menu, select Coding Tools, then select Coding Notes or press [F2]. The 
Notes Utility window opens. 

3. Enter or modify the text notes in the Analyst Coding Notes tab. 

4. Click Process Coding Notes to save or Close to exit without saving. 
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Printing Active File  
1. From the Tools menu, select Utilities, then select Print Active File or press [CTRL] + 

[P]. The Print Preview window opens.   

2. Use the buttons to scroll through the document.  

3. When you are ready to print, click the Printer icon to open the Print utility.  

View Coding for All Coders/Analysts 
If a Project contains coding from multiple coders/analysts, the View Coding for All 
Coders/Analysts option under the View menu must be active to display their coded text segments. 

Coder/Analyst Merge Utility 
The Coder Merge Utility scans the Project and reassigns the selected coder/analyst to your 
coder/analyst ID. This utility allows you to change the coder/analyst for all files in a Project or a 
selected file.  This process is referred to adopting another coder’s coding.  The Coder/Analyst 
Merge Utility can also be used to remove a coder’s coding.   

1. From the Tools menu, select Utilities, then select Coder Merge Utility. The Coder Merge 
Utility window opens. 

2. From the dropdown box, select the coder/analyst to change to your ID or to completely 
remove any coding that a coder/analyst has completed. 

3. Check whether to change for all files or for the selected file only. 

4. Click on the Process coder Merge/Remove button. 

5. Repeat for any other coder/analyst. 

6. When you close the utility, the Text Segment list is rebuilt with the coding now assigned to 
your ID as the current coder/analyst. 
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Note: When coding belongs to another coder/analyst, coded text segment IDs will display in a 
blue-colored font.  While you can click on a text segment to view source and text coding applied by 
another coder, you cannot modify the text segment or coding that has been completed.  When you 
adopt another coder/analyst’s coding, the coded text segment IDs change to a white-colored font 
and make modifications to the coded text segment. 

Linking Families 
Any family may be reassigned to another family. This allows a family to contain coded segments 
across documents. Families may contain coded segments from both normal TXT/RTF files and 
HTML documents. When a coded segment is reassigned to another family, any of the coded 
segment’s child segments will also be reassigned. 

1. Select the desired coded text segment from the Coded Segment list. 

2. From the Tools menu, select Coding Tools, then select Assign ID to another Family. 

3. Select the segment from list to reassign to and click the Apply button. A confirmation box is 
displayed. 

4. Click Yes to proceed with reassignment. 

5. After the reassignment process is completed, a confirmation displays with the new segment 
ID. 
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Chapter 9: 
The System Reports 
To open the report utility, open a Study and choose System Reports from the AnSWR Main 
Window File menu or the Coding Editor File Menu.  [CTRL] + [R] will also initiate the System 
Reports.  

 
Seven categories of reports are provided: 

• Data Tables or List Reports.  Reports in this group provides output for items such as 
codebooks, direct entry text files, SPS data tables, and sourcebooks, including  demographic 
data entered in the Advance Source Utility. 

• Text-based Analysis Reports.  Reports in this group fall into two categories: coded text 
reports and coder/analyst notes. 

• Numeric-based Analysis Reports.  Reports in this group include: code frequency tables, 
binary matrices, valued matrices, coding combination tables, and salient coding pattern 
reports. 

• Cross Tab Analysis Reports.  Reports in this group include a variety of two-by-two data 
tables: source data X source data; code X source data; and code X code outputs.  Up to 40 
codes may be displayed for code X code outputs. 

• Coder/Intercoder Analysis Reports.  Reports in this group in a variety of intra- or 
intercoder agreement reports: Kappa statistics at the file, source, or segment level; segment 
by segment coding comparisons for one or more coders; and a coder summary table. 
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• Word Count Analysis Reports. Reports in this group include alias and exclusion lists, 
segment-based word counts, and Project-based word counts. 

• Quality Assurance Reports.  Reports in this group provides summary tables for quickly 
identifying use of codes, sources, source data, text files, and text segments, including missing 
information. 

Set Up the Report  
You can run a report at the Project level. The steps for setting up a report include:  

• Select a Study and Project. 

• Choose a report type. 

• Set report criteria. 

• Choose the file for the report. 

• Run the report.  

Select Study, Project, and Report  
1. Choose a Study, and click on a Project to select it. 

2. After selecting the Project, choose a report group and expand it by clicking on its plus sign. 
Reports are listed in seven groups. 

3. Select a report by clicking its checkbox. To see detailed instructions for a report, select it, 
then click the Display Help for Selected Report button at the lower right corner of the 
screen.  

4. Set Report Titles  

5. AnSWR creates a default report title and subtitle based on the Study and Project names. You 
may edit these titles. 

6. Click the Next button in the toolbar to continue to the Report Selection Criteria window.  
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Set Selection Criteria  
The Report Selection Criteria Window is used to limit report output.  If no selection criterion is to 
be used, click on the Next button to bypass this function. 

The Report Selection Criteria Window displays a grid that is divided into 6 columns: Grp#, 
Report Tables, Table Fields, Select <=>, Selection Criteria, and a Group Operator.  The Select <=> 
column is referred to as the operator specification column.  

  
Note. The group operator column does not automatically display a column header.  When selection 
criteria is set for Grp#1, the group operator column will display a Select AND/OR.   

Build a Criteria Group  
There are two types of criteria groups, standard and Boolean.  

Standard criteria: runs a one-to-one comparison; each record must meet the criteria to be 
included in the report. Each report group may reference only one table/field combination.  

Boolean criteria: runs various comparisons and allows “AND” and “OR” search and retrieval. 
The search examines each coded Family ID to see if all conditions of the group are met.  

EXAMPLE: 

A and B.  Both A and B must be present (true) for the condition to be satisfied. This 
expression is used if only instances of co-occurrence between two or more criteria are 
sought. 

A or B.  Either A or B or both must be present (true) for the condition to be satisfied.  This 
expression is used if any combination of two or more criteria is sought (i.e., both individual 
occurrences and co-occurrences). 

A not B.  A must be present (true), but B must not be present (false) for the condition to be 
satisfied.  This expression is used if presence of one criteria item is contingent upon the 
absence of another. 

Set the criteria using the dropdown lists for each category in the Report Wizard. The system 
automatically uses the Report Field to determine if selection criteria will use Standard or Boolean.   

The Boolean Criteria Fields, which will display in a blue colored font, are: 
• Code 
• Code Network 
• Code Network Item 
• Code Value 
• Source 
• Source Network 
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• Source Network Item 
 

For the rest of the Fields, Standard Selection produces only those records that meet the specified 
condition (Gender = Female).  A combination of Standard and Boolean selection criteria can be 
used if more than one conditional set of relationships is sought.  Each set of conditions is 
introduced as a Group.   

 
Set criteria line-by-line (i.e., each row represents a new criteria item). Click on the gray-colored 
square next to the number displayed in the Grp# column to set a group function.  Group functions 
can also be run by clicking the colored buttons below the criteria table; roll your mouse over each 
button to choose a function.  

 

• The red dot creates a new criteria group 

• The lime green dot inserts a new row between criteria items 

• The turquoise blue dot deletes the selected row 

• The hot pink dot deletes all criteria for the selected group 

• The olive khaki dot completely clears all selection criteria 

• The teal green dot displays the Boolean Group rules window 

As you set report criteria, the next type of criteria becomes available to set. Click on the down arrow 
to view and select options. 
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Standard Selection criteria only allows an OR operator.  A new group must be added to perform 
an AND operation.  

 
For the Boolean Criteria Fields, only the AND operator is displayed in the Select AND/OR 
column.  To make the OR operator available, a new criteria group must be added. 

 

Set Boolean Group Rules  
If the Boolean-based criterion contains more than one group, Boolean Group Rules can be applied.  
If no Boolean Group Rules are set, all conditions must be met for records to display.  The Boolean 
Group Rules allows you to display records where fewer conditions are acceptable.  For example, you 
may create Boolean selection criteria where the presence of three specific codes is required.  With 
the Boolean Group Rules, you can then specify that it is permissible to display any record where a 
combination of any two of the three codes is present. 

To set Boolean Group Rules: 

1. Click on Grp# column to display the group functions or click on the teal green dot.  

2. Select the Boolean Criteria Group Rules option. 

3. Enter the number of rules to be met. 

4. Click the Apply button once all rules have been set. 

Save Criteria  
The report criteria settings may be saved and reopened to rerun a report using the same criteria. 

To save criteria settings: 

1. Click the Save Report Criteria button. A browser window opens. 

2. Select the location where you would like to store the criteria data file. It is recommended that 
you save the report criteria file under the default location (c:\program files\AnSWR folder). 

3. Enter the name of the file. 

4. Click the Open button to save the criteria data 
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5. Refer to Clearing Criteria and Loading Criteria (below) for information on how to clear 
criteria or load previously saved criteria. 

Load Saved Criteria 
To load saved criteria: 

1. From the File menu, choose Report Options, then Load Saved Criteria.  

2. Choose the criteria file from the browse window, and click the Open button, or Cancel to 
exit.  

Clear All Criteria 
To clear criteria:  

1. Click once in the Group column to activate the dropdown list. 

2. Choose Clear All Criteria.  

Set Report Style  
Report Style is applicable to only to the analysis reports (text-base, numeric-based, cross-tabs, and 
intercoder). The report style determines how report criteria will be processed and defines how the 
system creates the report output. The default report style is Segment-based.  

There are five report styles.  

• Segment-based analysis. Selection criteria groups are derived from the text segments. For 
example if is two codes are selected using an AND operator, both codes must be applied to 
a text segment for the record to display. 

• Source-based analysis. Selection criteria groups derived from the Source Data Report 
Table take precedence over any other selection criteria groups. After AnSWR completes the 
source-based limitations specified, it processes the remaining criteria.   

• File-based analysis. Selection criteria groups derived from the Files/Direct Input Report 
Tables take precedence over any other selection criteria groups. After AnSWR completes the 
file-based limitations specified, it processes the remaining criteria.  

• Code-based analysis. Selection criteria groups derived from the Codes or Codebook 
Report Tables take precedence over any other selection criteria groups. After AnSWR 
completes the code-based limitations specified, it processes the remaining criteria. 

• Coder-based analysis. Selection criteria groups derived from the Coder Data Report Table 
take precedence over any other selection criteria groups. After AnSWR completes the coder-
based limitations specified, it processes the remaining criteria. 
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To set the report style:  

Note: The system automatically opens the Report Style window at unless a default report style has 
been set. 

1. Click the Report Style button on the Selection Criteria window. 
 

2. Select the desired report style. If you wish to set this as the desired default report style also, 
check the option Set as default report style.  

3. Click the Apply button to save changes. 

 

Set Code Style  
Some analysis reports allow for selection of a code style. Code style determines which codes for a 
code network will be printed on a report. The default is to print only the network code(s) applied. 
By changing the code style, all codes for a network may be printed, even if they were not directly 
applied.  

1. To open the Code Style window, click the Set Code Style button on the Selection Criteria 
window. The button is displayed only for reports that utilize code style setting. 

2. Select the desired code style. If this is the desired default code style also check the Set as 
default code style.   

3. Click the Apply button to accept the selected code style. 

 

 
 

79



   

Note: The code style can also be set prior to creating selection criteria (or if no selection criteria is 
to be used) by click on the Set Code Style button after the Study and Project has been selected. 

 

Display Report  
After you set the desired criteria, click the Next button for additional options and to display the 
report.   

Select Sort Option  
Some reports allow multiple sort options. Click on a sort option to select it. If you change the sort 
option, you must run the report again.  
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Select Report Options  
Many of the reports allow you to set or limit data to display on the report. Check the options to set 
them to print.  

Create and View Report  
The finished report is displayed on the right side of the report window. Use the report display 
controls at the bottom right corner of report window to zoom in on the report or change the 
displayed page. 

Page buttons Moves through the pages of the report 

Zoom control Zooms in or out on the report for easier viewing of report details 

Print Opens the print dialog box 

Maximize Report Window  Displays the report at full screen 

Create Report Processes the report 

Save/Load Document  Allows you to save the report or load a saved report 

Close Closes the report window and returns to the previous screen 

For most reports, the default version of the report displays when the report window is open. The 
report must be recreated if you modify report options or request an HTML version or ASCII 
delimited version. Some reports display an additional window with more options for defining which 
data to include. 

Save Report in Another Format 

• ASCII Delimited File. Many reports may also be created in an ASCII delimited format. 
The first record of the ASCII delimited file contains the field names. The system uses the 
(^) character to separate data fields. Reports that can create an ASCII delimited file have the 
option to run an ASCII version of the report.  
To create an ASCII version of the report, select the Create report as ASCII delimited 
Report checkbox and follow the screen prompts to save the file.  

• PDF. Every report can be presented as a PDF. A PDF can be opened or printed by any 
other user. 
To create a PDF, select the Create a PDF Document from Displayed Report option and 
follow the screen prompts to save the file.  

• HTML. Every report may also be created as an HTML document. The HTML version of a 
report is similar to the displayed report except that it excludes graphics shows data left-
justified. 
To run an HTML version of the report, select the Create HTML or RTF document 
checkbox and follow the screen prompts to save the file.  
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Close Report Window 
Click the Close button to close the report window and return to the Report Wizard.  

Other Reports 
Some of the analysis reports can be processed with the same criteria and data as the current analysis 
report. The Report Wizard shows a list of these reports.  

• Select any of the reports and click the View Report button. 

• To create a new report, click the New Report button on the main toolbar. 

• Click the Finish button to close the report wizard. 

Set SPS Preferences  
SPS Preferences determines how SPS phrase in coded text segments are displayed on reports. If SPS 
was applied in the Coding Editor, coders/analysts with SPS rights can print text-based reports with 
either the SPS phrase or the original text. 

SPS report preferences are active only during the current report session. The system default is to 
print the SPS phrase. 

To set SPS preferences:  

1. From the File menu, select SPS Preferences. The SPS Report Preference window opens. 

2. Select the desired option and click the Apply button. 

Graphs  
AnSWR offers an option to display graphs for many of the system reports.  For reports that offer 
graphs, the default is to create the graphs. You may turn off the graph option. The types and 
contents of graphs depend on the reports. AnSWR produces bar, stacked bar, or line graphs. Most 
reports can create graphs based on data in various combinations. To change graph types, click the 
desired graph type. A new graph displays data in the selected graph type. 
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Advanced Graph Settings 
AnSWR includes controls for more advanced graph settings. 

To bring up the Chart Control Property window, click the graph once, press [CTRL] + [F4] and 
then right-click on the graph to display the Chart Control Property window.  

 
The Chart Control Property window has a Help button for detailed information about advanced 
graph property settings.  

Change Graph Data Options 
When you change graph options, the graphs change automatically to reflect settings. To return to 
the default version, close and reopen the graph window.  

Click on the tab for the data properties you wish to edit. Data options may also be selected from 
combo boxes or grids, depending on the report. 
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Change Graph Range 
Enter the desired range. Note that if you change the range for the series that display along the X 
axis, the graph may be distorted. Click the Rebuild Graph button. 

Set Maximum High Point On/Off 
Most graphs keep a constant maximum high point, so changing graph settings keeps the displays in 
sync. Some graphs change the maximum high point based on the data being graphed; these have an 
option to set a constant maximum high point based on the highest value of all possible graph data 
combinations. 

Turn Grid Lines On/Off 
The default setting displays grid lines. To turn them off, select the No Grid Lines checkbox.  

Add Footer 
A footer of up to 80 characters may be added to any graph. To add or change a graph’s footer: 

1. Click the Add Footer button. The Footer window opens. 

2. Enter the desired footer text or delete current text to remove footer from graph. 

3. Click OK to save changes, or Cancel to exit without saving.    

Print or Save Graphs 
Clicking the Print/Save Graph button allows you to: 

• Add the graph to the current report for printing.  

Note: You may add any number of graphs to a report.  

• Save the graph as a JPEG or PNG file for use in other applications.  

To print or save, click the radio button for the option you want, then click the Apply button, or 
Cancel to exit this feature without printing or saving. If you choose to save the graph, a Save As 
box appears. Give the graph a title, browse to the location to which to save, and click the Save 
button (or Cancel to abort). The default location is C:\Program Files\AnSWR.  
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Chapter 10 
Sharing a Study or Project 
AnSWR Package Utility 
We recommend that you use the AnSWR Package Utility to share a Study or Project.  Before you 
share a Study or Project, it is always a good idea to compact the study30.mdb and the project 3.mdb. 

Package Study and Project(s) 
1. Exit AnSWR. 

2. Go to Start. 

3. Go to Programs and locate AnSWR. 

4. Select the AnSWR Package Utility. 

5. Click on the Package Study/Project tab. 

6. Select the desired Study. 

Note: When selecting a Study, all associated Projects are automatically included. 

7. Click on the Zip button.  The Study/Project will be packaged into a .ZIP file and saved in 
under c:\program files\AnSWR. 

8. Copy the .ZIP onto a diskette or CD from c:\program files\AnSWR. 

9. A confirmation message will display indicating the file name and location. The .ZIP file 
should not be renamed. 

10. Click on the Close button. 
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Package Only a Project 
To package a single Project folder: 

1. Exit AnSWR. 

2. Go to Start. 

3. Go to Programs and locate AnSWR. 

4. Select the AnSWR Package Utility. 

5. Click on the Package Study/Project tab. 

6. Select the desired Project. 

7. Click on the Zip button.  The Project will be packaged into a .ZIP file and saved in under 
c:\program files\AnSWR. 

8. Copy the .ZIP onto a diskette or CD from c:\program files\AnSWR. 

9. A message will display indicating the file name and location. The .ZIP file should not be 
renamed. 

10. Click on the Close button. 

 

Receive a Shared Study or Project 
To un-package a shared Study or Project you have received: 

1. Open Windows Explorer or My Computer. 

2. Copy Study or Project .ZIP file to c:\temp. 

3. Make sure AnSWR is closed and go to Start. 

4. Go to Programs and locate AnSWR. 

5. Select the AnSWR Package Utility. 

6. Click on the Receive Study/Project tab. 
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7. Click on the Select the Package (.zip) File to Unzip button.  A browser window will 
display 

8. Go to c:\temp to locate the Study or Project .ZIP file. 

9. Click on the Select the Folder to Unzip the Package To button. A browser window will 
display. 

10. Click on c:\.  Important: The pathname is written to the .ZIP file.  Do not go to 
c:\program files\answr\ to unzip the Study. 

11. A confirmation message will display indicating that the Study/Project has been unzipped. 

 
Note: If the Study to be unzipped already exists on your computer/server, a message will display.  
You have the option to rename the Study you are unzipping or to overwrite the existing Study folder 
with the zipped one. 

If a Project .ZIP file is to be unzipped, the Select the Folder to Unzip the Package To button 
will not display.  The system will automatically write the folder to the correct Study.  If a Project by 
the same name already exists, the system will save the Project under a new Project Folder. The 
Project name will now be followed by an underscore and a number. 
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Note: If another coder/analyst has provided a copy of his/her Project for intercoder agreement 
assessment, it will be necessary to use the Project Merge Utility to create a new Project containing 
your coding and their coding. 

Manually Sharing a Study or Project 
If you receive a Study from another coder/analyst that you have never created on your 
computer/server, it must be introduce to the system.  This is done by creating a new Study using the 
exact name that the other coder/analyst gave it. Before this is done, however, you must use My 
Computer or Windows Explorer to manually copy the entire Study folder to your computer or 
network server. Below are instructions for copying AnSWR databases from one PC to another. 

Copying AnSWR Study onto a Diskette 
1. Open Windows Explorer. 

2. Locate your Study. If the default location was used, your Study is in the C:\Program 
Files\AnSWR folder. 

3. On the left panel of Windows Explorer, click your Study folder, then right-click and select 
Copy.  

Note: If your Study is large, it may be necessary to use one of the compression programs 
like WinZip, PKZip, or Windows Commander to compress your files so that they fit on a 
1.44 or 2.0 MB diskette. 

4. Insert a formatted diskette or CD into the appropriate disk drive. 

5. Click on the disk drive containing the diskette or CD, right click, and select Paste.  

6. When you open the Study folder, you should see a study30.mdb file and your Project folder. 
When you open the Project folder, you should see a project3.mdb, textdata.mdb, [Project 
name]wc.mdb. 

Transferring Copied AnSWR Study onto Another PC 
1. Open Windows Explorer on the other PC. 

2. Click on the appropriate diskette or CD, click on the Study folder, right click, and select 
Copy. 

3. Go to the same path in which the Study was originally located on your desktop. The default 
path is C:\program files\answr. 

4. Right click and select Paste. 

Important: If the Study folder was copied from a CD, it is necessary to right-mouse click on the 
Study folder name, and select Properties.  Uncheck the Read Only box and click on the Apply 
button.  A Confirm Attribute Changes window will display.  Check on the radio button to 
Apply changes to this folder, subfolders, and files, and click on the OK button. 
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Authenticating Transferred AnSWR Study on Another PC 
1. Start AnSWR and log in. 

2. Click on New Study button and enter name of the Study that was transferred from your 
desktop. Make sure to type in the name exactly as it was entered originally on your desktop. 

3. When the Project Wizard comes up, click on the Cancel button. 

4. If AnSWR main window does not display the Project name: 

a. In the File menu, click Open Project. 

b. Locate the Study in the display window. 

c. Click on the option to synchronize the Project. 

d. Select your Project. 

Once you have completed the coding on your other PC, repeat steps A and B to get the Study 
copied back to your desktop. A dialog box will appear, asking if you want to overwrite the existing 
folder. Click Yes. 
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AnSWR Hot Keys 

AnSWR Main Window Hot Keys 
 
[CTRL] + [N] Create New Project 

[CTRL] + [O] Open Existing Project 

[CTRL] + [M] Modify Active Project 

[CTRL] + [D] Delete Active Project 

[CTRL] + [W] Initiate Project Merge Wizard 

[CTRL] + [C] Open Codebook Editor 

[CTRL] + [S] Open Sourcebook Editor 

[CTRL] + [T] Open Coding Editor 

[CTRL] + [R] Initiate System Reports 

[CTRL] + [E] Exit AnSWR 

 

Coding Editor Hot Keys 
  
[CTRL] + [A] Highlight All Text for Active File 

[CTRL] + [C] Copy the Selected Text to the Clipboard 

[CTRL] + [D] Display/Set Default Source 

[CTRL] + [E] Close the Coding Editor 

[CTRL] + [F] Segment an Entire File (Entire File Is One Text Segment) 

[CTRL] + [H] Toggles Text Highlight On/Off 

[CTRL] + [J] Display/Print List of Short Cuts/Hot Keys in the CTRL/F5 Window 

[CTRL] + [K] Display Short Cut/Hot Key Window (Note: Not All Hot Keys Are Displayed 
In This List) 

[CTRL] + [M} Activate Coder Merge Utility (Merges/Removes Selected Coder’s Coding) 

[CTRL] + [P] Prints the Active File 

[CTRL] + [Q] Quick Jump to ID, Code, or Source  

[CTRL] + [R] Open System Reports Module 

[CTRL] + [S] Display Coded Text Segment Summary Window 
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[CTRL] + [T] Display Direct Text Input Window 

[CTRL] + [V] Paste Clipboard Text at Cursor 

[CTRL] + [W] Perform Word Count for Active Text Segment/File  

[CTRL] + [Y] Display Word Count for Active Text Segment ID 

[CTRL] + [Z] Activate External File Utility 

[CTRL] + [F1] Display the Source Networks 

[CTRL] + [F2]  Display the Code list (Code Networks) 

[CTRL] + [F3] Display the Coded Segment Id List 

[CTRL] + [F5] Open the Sourcebook Editor 

[F1] Open Help File 

[F2] Display Code Notes 

[F3] Open the Codebook Editor 

[F4] Code HTML Document 

[F5] Go to Line/Position 

[F6] Perform Text Search 

[F7] Go To Unique Text Segment ID 

[F8] Display Code Options for Selected Code (Code Network Window Must Be 
Active) 

[F9] Perform Source Search (Source Network Window Must Be Active) 

[F11] Modify Text Segment Dimensions (Redefine Segment Begin & End Positions) 

[F12] Cancel Text Segment Dimension Change 

[SHIFT] + [C]  Display Word Count for the Active Coded Text File 

[SHIFT] + [F2] Open/Begin Segment 

[SHIFT] + [F3] Close/End Segment 

[SHIFT] + [F4] Select Text Segment 

[SHIFT] + [F5] Display Family ID Information Window 

[SHIFT] + [F6] Display Text Segment Summary Window 

[SHIFT] + [F7] Display Sources for Active ID in Family ID Information Window 

[SHIFT] + [F8] View Coding Notes for Active Text Segment  
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[SHIFT] + [F9] View Coding for All Coders/Analysts 

[SHIFT] + [F11]  View Unique ID for Segment 

[SHIFT] + [F12]  View Coder/Analyst for Segment 

[CTRL] + SHIFT + ’KEY’  Moves to First Item on ID, Code or Source List Beginning with Key 
Entered 

 

Codebook/Sourcebook Editor Hot Keys 
[CTRL] + [A] Add All Code/Source Networks to the Project 

[CTRL] + [D] Delete Code/Source from the Study 

[CTRL] + [E] Edit the Code Network Definitions 

[CTRL] + [F] Delete the Network Item from the Network Structure 

[CTRL] + [H] Make Code/Source a Network Holder 

[CTRL] + [L] Lock the Code/Source Network Structure 

[CTRL] + [N] Change the Code/Source Network Name 

[CTRL] + [Q] Close Codebook/Sourcebook Editor 

[CTRL] + [R] Set Relationships/Connections between Code/Source Networks 

[CTRL] + [X] Always Expand Code/Source Network Trees 

[CTRL] + [Z] Use the Change Analysis Process to Assign Code/Source Application to 
another Code/Source 

[F1] Open the AnSWR Help File 

[SHIFT] + [F1] View All Study Code/Source Networks 

[SHIFT] + [F2] View Project Code/Source Networks Only 

[SHIFT] + [F3] View Only Code/Source Networks Not in Active Project 

[SHIFT] + [F4] View Code/Source Networks Missing Required Data 

[SHIFT] + [F5] View Code/Source Networks Based on the Order They Were Added to the 
Codebook/Sourcebook 
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